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Using fields in title blocks 

Using drawing and sheet set properties in fields title blocks can be filled out nearly automatically. 

Small projects, such as a family house, are usually drawn in a single drawing with multiple layouts. In 
large projects multiple drawings are used, each containing one or more layouts, which can then be 
grouped as sheets in a sheet set. Apart from the default drawing, sheet set and sheet properties, such 
as the project name and description, custom properties, such as name and address of the owner and 
the architect, can be defined. 

The creation of a title block consists of the following steps: 

1. Drawing the layout of the title block: borders, logos, labels, … 

2. Adding attributes with fields to define the variable content of the title block. 

1.1 Title blocks in a small project 

1.1.1 Defining custom drawing properties 

1. Open the drawing Template_SmallProject.dwg. 

2. Open the Foundation layout. 

The title block looks like this: 

 

If the FIELDDISPLAY system variable is ON, fields display on a gray background, which is not 
printed. 

The FIELDEVAL system variable defines when fields are updated. The options are: commando’s 
REGEN, SAVE, ETRANSMIT, PLOT / PRINT and/or when opening the drawing. 

The UPDATEFIELD command prompts to select the fields to be updated. 

Hyphens (----) display in fields that refer to a property which is not specified yet. 

3. In the File menu choose Drawing Properties… 
The Drawing Properties dialog box opens. 

4. Click the General tab to see the default drawing information. 
Fields on the General tab cannot be edited. 

5. Click the Summary tab to see the default editable drawing properties. 

Fill out the following fields: 

 Title: House 

 Subject: Family House 

 Author: Bricsys 

Click the OK button to confirm. 
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6. Click the Regen tool ( ) in the Redraw/Regen toolbar 
or 
Type regen in the command bar. 

The content of the title block is updated.  

7. Reopen the Drawing Properties dialog box. 

8. Click the Custom tab to see the custom properties. 

9. Do one of the following to edit an existing custom property: 

 Select the property, then click the Edit button. 

 Double click the property. 

The Custom Property dialog box displays: 

 

10. Type a new name in the Value field, then click the OK button. 

11. Define the other custom properties as indicated in  the image below. 

 

12. Click the OK button on the Drawing Properties dialog box. 

13. Choose Settings in the Settings menu, then lookup the FIELDEVAL system variable under 
Program Options / User Preferences. 

The FIELDEVAL system variable defines when the fields in a drawing are updated. 
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The value of the FIELDEVAL system variable is saved in the drawing and therefore might vary 
between drawings. 

 

14. Do one of the following to update the custom drawing properties fields in the various title blocks: 

 Save the drawing. 

 Execute the REGEN command. 

1.1.2 Create a custom property 

1. Open the drawing Template_SmallProject.dwg. 

2. Choose Drawing Properties… in the File menu. 
The Drawing Properties dialog box displays. 

3. Click the Custom tab. 

4. Click the Add button. 

 

5. Type a name in the Name field. 

6. Type the definition in the Value field. 

7. Click the OK button. 
The new property is added and can now be used in a field. 

1.1.3 Composing the title block 

In a  title block we will create three types of texts: 

 Ordinary texts (texts) 

 Attributes 

 Fields 

In the title block in the drawing Template_SmallProject.dwg exist: 

1. Attributes: 

 Remark 

 Revision 

 Number 

 Scale 

 Title 
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2. Drawing property fields: 

 Summary/Subject 

 Custom/Architect 

 Custom/ArchitectAddress 

 Custom/Owner 

 Custom/OwnerAddress 

 Custom/SiteAddress 

 Custom/SiteReference 

 Custom/ProjectNumber 

3. Fields: 

 Date/SaveDate 

1.2 Title blocks in a large project 

A large project consists of a large number of drawings in different folders. Based on this folder 
structure, we will create a sheet set with layouts of the project drawings. 

1.2.1 Creating the sheet set 

1. Click the Sheet sets… tool ( ) in the Standard toolbar. 

The Drawing Explorer – Sheet Set dialog box displays. 

2. Click the New Sheetset icon ( ) in the Drawings panel. 

The Create New Sheet Set dialog box displays. 

3. Choose Use Existing Drawings then click on the Next button. 

4. Click on the Select Folder… button and select the folder ..\Exercises\House. 
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5. Select the layouts you want to include in the sheet set. 

Do the following: 

 If you immediately click the Next button, all layouts are included in the sheet set. 

 Right click for a context menu: 

 

 Keep the Ctrl-key pressed to add or remove a layout. 

6. Click the Next button. 

7. Type House in the Save sheet set file as field and click the Browse button ( ) to select a 
folder. 

The Save new sheet set as dialog box displays. 

8. Select the ..\Exercises\House folder and click the Save button. 

9. (Option) Type a description in the Description field. 

10. (Option) Click the Browse button ( ) to select a template drawing for new layouts. 

11. Click the Next button. 

An overview of the structure of the new sheet set displays. 

12. Do one of the following: 

 Click the Back button to make corrections in one of the previous screens. 

 Click the Finish button to create the sheet set. 

The new sheet set opens in the Drawing Explorer – Sheet Set dialog box. Click the sheet set name 

to see the sheet set properties. 

 

 

Click on the name of a subset to see the subset properties. 
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Click on the name of a sheet (layout) to see the sheet properties. 

In the Preview panel a thumbnail image of the layout displays. 

 

1.2.2 Defining custom sheet set and sheet properties 

1. Open the sheet set House.dst. 

2. Click the Custom Properties… icon ( ) in the Sheets toolbar in the Drawing Explorer dialog 
box.. 

The Custom Properties dialog box displays. 
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3. Click the Sheet Set tab then click the Add… button. 

.  

 Type a name for the new property in in the Name field. The Value field can be left empty. 
We will fill this out later in Drawing Explorer dialog box. 

 Add the following properties: 

 Contractor 

 ContractorAddress 

 ContractorCity 

 Architect 

 ArchitectAddress 

 ArchitectCity 

 ArchitectPhone 

 Owner 

 OwnerTitle 

 OwnerAddress 

 OwnerCity 

 SiteAddress 

 SiteCity 

 SiteReference 

4. Click the Sheet tab then click the Add… button to add the following Sheet properties: 

 Date 

 Remark 

 PaperSize 

 Printer 

 Scale 

  



BricsCAD Basic Training 

8 

 

1.2.3 Specifying sheet set and sheet properties 

1. Click the sheet set name to specify the sheet set custom properties: 

 

2. Click a sheet name to specify the sheet properties: 

 

 

1.2.4 Composing the title block 

The title block we are composing must be useable in all drawings of different projects. Therefore we 
will use fields in attributes to add the sheet and sheet set properties. 

In this title block we will add: 

 Texts for the labels 

 Attributes: 

 Text attributes 

 Fields 

In the drawing TitleBlocks.dwg the overall layout of a title block is already prepared. To be able to 
add the sheet set and sheet properties, the layout of this drawing must be added to the House.dst 

sheet set first. 

1. Open the House.dst sheet set. 

2. Right click the sheet set name and choose New Sheet(s)… in the context menu. 

3. Choose Import layouts from existing drawings. 

4. Select TitleBlocks.dwg and click on the OK button. 
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5. Double click the TitleBlocks – DETAIL sheet to open the drawing TitleBlocks.dwg. 

We will now add the sheet set and sheet properties as fields in attributes. 

6. Choose Attributes > Define Attributes in the Tools menu. 

The Define Attribute dialog box displays: 

 

7. Type a name for the attribute in the Tag field then press the TAB-key to go to the next field. 

8. (option) Type a prompt in the Prompt field then press the TAB-key to go to the next field. 

9. Delete the default text Value in the Default field. 

10. Click the Insert Field button ( ) next to the Default field. 

The Define Attribute dialog box closes. 
The Field dialog box displays. 

11. Expand Sheet Set fields list. 

12. To select a Default Sheet Set field: 

 Select the field in the list. 
The current definition of the selected field displays in the Value field in the Field dialog box. 
If the field is not specified yet, dashes (---) display in the Value field. 
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 (option) Select a format for the field in the Format options list. 

13. To select a Custom Sheet Set field: 

 Select CurrentSheetSetCustom in the list (1). 
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 Open the Custom property list (2). 

 Select a property in the list (3). 
The current definition of the selected field displays in the Value field in the Field dialog box. 
If the field is not specified yet, dashes (---) display in the Value field. 

14. Click the OK button to confirm. 

The Field dialog box closes. 
The Define Attribute dialog box reopens. 

15. Define the text properties: 

 Text Style 

 Justification 

 Height 

 Rotation 

16. To specify the insertion point:  

 Click the Pick Point button ( ). 
The Define Attribute dialog box closes. 

The command bar reads: Select insertion point: 

 Specify the insertion point in the drawing. 
In TitleBlocks.dwg snap to the endpoint of the construction lines to define the insertion 
point of an attribute. 
The Define Attribute dialog box reopens. 

The coordinates of the insertion point display in the x-, y- and z-fields. 

17. Click the OK button to create the attribute. 

18. Press Enter to define the next attribute . 
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The complete title block: 

 

1. CurrentSheetSetCustom/Architect 

2. CurrentSheetSetCustom/ArchitectAddress 

3. CurrentSheetSetCustom/ArchitectCity 

4. CurrentSheetSetCustom/ArchitectPhone 

5. CurrentSheetSetDescription 

6. CurrentSheetSetCustom/SiteCity 

7. CurrentSheetSetCustom/SiteAddress  

8. CurrentSheetSetCustom/SiteReference 

9. CurrentSheetSetCustom/OwnerTitle 

10. CurrentSheetSetCustom/Owner  

11. CurrentSheetSetCustom/OwnerAddress 

12. CurrentSheetSetCustom/OwnerCity 

13. CurrentSheetSetCustom/Owner 

14. CurrentSheetSetCustom/Architect 

15. CurrentSheetSetCustom/Contractor 

16. CurrentSheetTitle 

17. CurrentSheetIssuePurpose 

18. CurrentSheetSetProjectNumber 

19. CurrentSheetCategory 

20. CurrentSheetCustom/Scale 

21. CurrentSheetCustom/Date 

22. CurrentSheetCustom/PaperSize 

23. CurrentSheetNumber 

24. CurrentSheetSetSheetCount 

1.2.5 Creating the title block as a dwg block 

1. Continue working in the drawing TitleBlocks.dwg. 

2. Switch off the display or freeze the Construction Lines layer. 

3. Choose Create Block in the Tools menu. 

The Block definition dialog box displays: 
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4. Type TitleBlock in the Name field. 

5. (option) Type a description in the Description field. 

6. Click the Select entities button. 

The Block definition dialog box closes. 

7. Select all visible entities, then right click to conclude the selection. 

The Block definition dialog box displays. 

The number of selected entities is indicated. 

8. Click the Pick point button ( ) to specify the Base Point of the block in the drawing. 

9. Snap to the bottom right corner of the outer border of the title block. 

10. Choose Retain to keep the selected entities in the drawing. 

11. Choose Centimeters in the Block unit list button. 

12. Click the OK button to create the block. 

1.2.6 Making the title block available in other sheet sets 

1. Remove the drawing from the sheet set: 

 Select the layout of TitleBlocks.dwg in the House.dst sheet set. 

 Right click, then choose Remove Sheet in the context menu. 

2. Save the TitleBlocks.dwg in a folder where you save the drawings with your default blocks (see 
11.4.2 Inserting blocks from other drawings in Module 4).  

3. You can now insert the title block in each of the layouts of a sheet set wherein the same custom 
sheet set and custom sheet properties exist.  

 All fields in the title block will be filled out automatically.  

 Fields that are not specified yet display with hyphens (----). 

1.2.7 Using a Sheet set as a template 

One of the options to create a new sheet set is Use Template, which makes a copy of an existing 
sheet set and saves it to a different location. In the process all custom properties 
(CurrentSheetSetCustom and CurrentSheetCustom) are copied along.  
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To save a sheet set as a template 

1. Create a folder for your sheet set templates. 

2. Copy House.dst to this folder. 

3. Rename the sheet set, e.g.: TemplateSheetSet.dst. 

4. Click the Sheet Set tool ( ) in the Standard toolbar. 

5. Click the Open Sheet Set icon ( ) in the Drawing Explorer dialog box and open the template 
sheet set. 

6. Remove all sheets from the sheet set and its subsets: 

 To select a series of sheets: select the first sheet, then press and hold the shift key and 
select the last sheet. 

 Right click and choose Remove Sheets in the context menu. 

To define the Sheet Set Template Path  

In BricsCAD the SheetSetTemplatePath user preference defines the sheet set template folder. 

1. Choose Settings in the Settings menu. 

2. Go to Program options/Files and select Sheet Set template path. 

 

3. Click the Browse button ( ) and select your sheet set template folder. 

4. Click the OK button. 

To create a new sheet set from a template sheet set 

1. Click the Sheet Set tool ( ) in the Standard toolbar. 

2. Click the New Sheet Set… icon ( ) in the Drawing Explorer dialog box. 

3. Choose Use Template in the Create New Sheet Set dialog box and choose a template sheet set. 

4. Click the Next button. 

5. Type a name for the new sheet set in the Save sheet set file as: field, then click the Browse 

button ( ). 

6. Select the folder to save the new sheet set in, then click the Save button. 

7.  (option) Type a description in the Description field. 

8. Click the Next button then click the Finish button. 

The new sheet set opens. 
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9. Click the name of the sheet set and define its default and custom properties. 

10. To add sheets, right click to display a context menu.  
Choose: 

 New Subset to add a subset. 

 New Sheet(s)… to add sheets to the sheet set or the currently select subset. 

11. Select each sheet and define the default and custom properties. 

12. Open a sheet (double click or right click and choose Open in the context menu). 

13. Click the Folders tab on the Drawing Explorer dialog box, then insert the title block from 
TitleBlocks.dwg. 
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